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1 About this Book

This book is designed to help you understand some basic concepts of the
openCRX package productl, which allows you to design, configure, and
manage complex products and their prices.

1.1 Who this book is for

The intended audiences are openCRX administrators and openCRX users.

1.2 What do you need to understand this book

A basic understanding of how to read UML diagrams.

1.3 Tips, Warnings, etc.
We make use the following pictograms:

Information provided as a “Tip” might be helpful for various reasons:
time savings, risk reduction, etc. - it goes without saying that we

Tin advise to follow our guides meticulously
meticulous \muh-TIK-yuh-luhs\, adjective:
Extremely or excessively careful about details.
You should carefully read information marked with “Important”.
Ignoring such information is typically not a good idea.
Imporiant

Warnings should not be ignored (risk of data loss, etc.)

T
arning
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2 Prerequisites

If you intend to reproduce the examples given in this guide, you might want to
make sure you have a access to a working instance of openCRX. For detailed
information on how to setup/install an openCRX instance, see
http://www.opencrx.org/server.htm for more information.

Enter the sample data as explained below.

2.1 Sample data

With the following steps you can enter the test data used in this guide:
e launch your browser, connect to openCRX, and login as user guest
e navigate to [Products]

e in the grid tab [Active Price Levels] select New > Price Level and then
enter values as follows to create the Price Level Standard:

Untitled - Price Level

General || System *

Mame: [ Standard

Based on:

Is final: Fli
Walid from: ( 01/04/2040 06:00:00 AM %

Walid to:

Description: - g IR
S5tandard Prices

P

Conrac Fikers

Payment methods: =_ Shipping methods: =_
Pri ors

Cumency: (ELIF{[Eur-:}] _v_] Price usage: =
Save| | Cancel

click [Save] to complete the creation of the Price Level Standard
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Prerequisites

e select New > Price Level again and then enter values as follows to

create the Price Level Sales:

Untitled - Price Level

General | | System

Mame:

(=

Based on:

Desoiption:

Corract Fibers:
Payment methods:

Price Fikers

et

Cumency:

EEUR[EUH}]

=)

Save| | Cancel

Is final:

O

Valid from:
Valid to:

05/01/2010 06:00:00 AM &%
05/16/2010 10:00:00 PM &%

Shipping methods: =

Price usage: =

click [Save] to complete the creation of the Price Level Sales

« still in [Products], select the Operation File > New Product to launch the

product creation wizard:

Home Accounts Activities Pipeline  Products Depots
44 Products
1]
File Edit View Actions Security Wizards
Imiport Product Configurations / Properties from Excel File...
New Product .
e W 4 pneRomE New
] Product # =

Edit
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e enter data as shown below and then click [Save] to create the

Product

Widget A:
Home Accounts Activities Pipeline | Products Depots »
33 Products
]
File Edit View Actions Security Wizards
Product
Mame: Widget & Expires on:
Product status: Active [v] (-EEEE tax type: Sales Tax 8.5%
Preduct numb-er: WA-1000 Gross Weight Kilogram:
Unit of measurement: Piece(s) MNet Weight Kilogram:
Activenfalid from: e Preduct Dimension:
Dreg.oriprelon
Description: I g —
Large Widget
Detailed desoription: mren
Prices:
Frice Discount is
- . " - . . .
Level Usage Cumency Cuantity from Duantity to Price 5 Disce

-| Standard EUR ( 1|:n:|] ]

- | Sales EUR { ) 0] [

~ Sales ewr 10]) { 0] O
Product Frice -
Usage: = Cuantity to:
Based on: Sales Discount is %: D
Price: 20.00 Discount:
Cuantity from: 10.00

+

Save  Cancel

Use the auto-completer feature of openCRX to populate the fields
Sales tax type and Based on (type the first few characters and then

Tin

select the appropriate value from the drop down). To populate the

field Unit of measurement you must use the lookup inspector (i.e.
click on the lookup icon and then navigate to [UOMs (Root)] and
select Piece(s) from the available UOMs); the autocompleter
searches in the current segment (Standard) only and will not be able
to find Piece(s).
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If you started out with an empty database you might have to create a
Sales Tax Type yourself; the database provided with the openCRX
installer includes a sample Sales Tax Type Sales Tax 8.5% already.

o product Widget A should look as follows and have 3 base prices:
Home Accounts Activities Pipeline  Products Depots »

&3 Products = Widget A | WA-1000 - Product =
File Edit View Actions Security Wizards

General || Details | System

Mame: Widget A Froduct numbser: VWA-1000
Description: Large Widget ActiveNalid from:

Product status: Active Expires on:

Min positions: Default positions:

Max positions:

Ceonfiguration type:

Min quantity: Default quantity:
Max quantity: [min..max] handling: 0
Offset guantity:

Detailed desoiption:

i Price UCMs | | Addresses  Descriptions
E2) =N FOONME Mew Edit Wiew
L D Frice Levels = Usage Currency = Price = Unit of measurement = Description = Guantity from = Guantity to

&3 Standard EUR 100.00 Pieoa(s)
&3 Sales EUR 20.00 Fiece{s) 2.00
&3 Sales EUR 20.00 Pieca(s) 10.00
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e navigate back to [Products] and select the Operation File > New Product
again to launch the product creation wizard

e enter data as shown below and then click [Save] to create the Product

Widget B:

Home Accounts Activities Pipeline Depots =
&3 Products
L]
File Edit WView Actions Security Wizards
Product
Mame: Widget B
Product status: Active [i]
Product numb-er: WB-1020
Unit of measurement: Piece(s}
ActiveNValid from: =
De=soriprion
Description: B —
Small Widget

Detailed desoription: L
Prices

Frice u - - Quantity fr Cusntity 4

Level sage Cumency Quantity from Quantity to

- Standard EUR
- Sales EUR

Froaduct Frice
Usage: =
Based on: Sales a
Price: 40.00

Cuantity from:

+

Save  Cancel

Expires on:
€E|E‘5 tax type:

Sales Tax 8.5% ]

Gross Weight Kilogram:

Met Weight Kilogram:

Proeduct Dimension:

Price

Discount is
%
EI]] |
dI]] 1

Cuantity to:

Discount is %:

Discount:

Dis

o
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« Product Widget B should look as follows and have 2 Base Prices:
Home Accounts Activities Pipeline | Products Depots »
33 Products > Widget B / WB-1020 - Product
File Edit View Actions Security Wizards

General || Details = System

Mame: Widget B Product number: wB-1020
Desoription: Small Widget ActiveNalid from:

Product status: Active Expires on:

Min positions: Default positions:

Max positions:

Configuration type:

Min quantity: Default quantity:

Mazx quantity: [min..max] handling: 0

Offset quantity:

Detailed desoription

Active Base Prices EE!EE F‘rinssg Price UCMs | | Addresses | | Descriptions

hal g, FNONME Mew Edit View

L |:| Price Levels = Usage Currency = Price =  Unit of measurement = Description = Guantity from = Gruantity to
34 Standard EUR 80.00 Piece{s)

33 Sales EUR 40.00 Fisce(s)

The following figure shows an overview of the sample data created by the

above steps:

EUR 100.-
EUR 90.- 1
| EUR 80.- F—I_l
SalesTaxType Sales Tax 8.5% Pricelevel Sales Pricelevel Standard
tax rate in %: 8.50 valid from: D1-05-2010 | K710y F s Bk Ese.li b i)
valid to: 16-05-2010 | REIGRGE

|

EUR 40.-

EUR 60.-

Figure 1: Sample data - 2 products, 2 price levels, 5 base prices
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3 Products

openCRX products are objects that typically fall into one of the following
categories: goods, services, ideas, etc. While the default customizing of
openCRX enables many attributes useful for goods (like for example weight
and dimension information) it is easily possible to tailor the list of available
and/or visible attributes to your specific requirements with customizing.

openCRX provides a wizard that helps you create new products interactively
and populate the various attributes including price information. The wizard
New Product is available from the product segment in the File menu:

Home  Accounts Activities Pipeline | Products Depots »

| 33 Products
File Edit View Actions Security Wizards
Import Product Configurations / Properties from Excel File...
MNew Produdt... | 2
Name: [,.‘E Expire=s on: e
Product status: NiA | Sales tax type: a
Product number: Grozs Weight Kilogram:
Unit of meazurement: a, Net Weight Kilogram:
Activenvalid from: HE Product Dimension:
Crescription
Dezcription: TS P IR NE
Detailed description: TS FTHE NIRRT
Product Price
Uzage: = Quantity to:
Bazed on: a Dizcount iz % |:|
Price: Dizcount:

Quantity from:

+

Save || Cancel

Figure 2: Wizard New Product
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3.1 AbstractProduct

AbstractProduct is one of the core classes (all the relevant class diagrams
are all located in the package org.opencrx.kernel.productl), but it contains
only the most basic attributes. On the other hand, AbstractProduct inherits a
lot of attributes from other classes, including CrxObject (and hence, it is very
easy to add/enable additional attributes by customizing).

aroots aroots This softwars is published
AbsraciProduc ¥ ConractPositonConarained under the BED license as
+name : string listed below. se=class
+ description : string [0..1] = aroots dizgram _LICENSE
+ detailedDescription : string [0..1] A DepotReferen ceHolder
+ productM umber : string
+ productState | code = —
+ alists altemateProductMumber : string e arcois
+ activeOn : dateTime [0..1] CrxObjec
+expires On : dateTime [0..1]
aroots
& AddressCon@iner
ProductlsClassifiedAs . ——
e — 0.1 ProductClassification
L inden; © integer —>
+ product +classification
ProductHasU 1[
rodueinasTE 0.1 7T ActivityTracker
+ product + productUsage
ProductHasDefaulillom L
0.1 = Uom
+ product + defaultUom
. ProductH acAllowedFricellom o
o e ; integer -
+ product +pricellom
i i : string
+ profiuct
ProductHasAsgigned Account
= alnoots
+ assigneflAccount CrxObject
0 3
AccountAssignmentProduct
+ sccountRole | code
B alols
AccouncAssignment

Figure 3: Class Diagram productl.AbstractProduct

For information on how to “attach” prices to products, see chapter 5 Basic
Pricing.
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3.2 Product

openCRX Product inherits from AbstractProduct and introduces additional
concepts like

e Product Configurations

e Product Structuring (by means of relating products to one another)
e Product Phases

This software is published SRl
under the BS0 license as - -
fisted below. se= class = Cg W : string
diagram _LICENSE T arools
CrxObject +3segment
J?‘ SegmentCortainsProduct
A wroof A wroofs afoots
Description Conginer Pictured AbstraciProduct + profduct
Product
+isStockitem ; boolzan [0..1]
+ productDimension : string [0..1]
+ grossWeightKilegram : decimal [0..1
+ netWeightkilogram : decimal [0..1]
+ setConfigurationType { in . SetConfigurationTypeParams ) : Ved
4? g W - string g id - string
1 0..1 i
aroots - " + profuct
. + parentFroduct + proguct
ProductConfiguratonSer ) ProductContainsProductPhase
ProductHasRefatedProduct ~ ProductiacRelaion
- . - )
+ productC opfigurationSet C;E;a
+ relst=dProduct + relst=dFroduct dJudiPhase
ProductConfiguyation Set=0fype - . ’ ;r{t .
+ configType Related Product ProductPhase
ot + relationshipType : code +name : string
- +name : string + description : string [0..1]
ProductConfigurationTypeS5et + description : string [0..1] + productPhasekey - string [0..1]
+ validFrom : dateTime [D..1]
+ validTo : dateTime [D..1]
astructs — T
’ relationshipTypse: -
SetConfigurationTypeFarams spgr=gat -ml: —ysp;nilar . A product phase which is active in period
+ configuration Type - ProductConfigurationTypeSe dependency - parent [validFrom, validTo]. Product phases ae
used e.g. in Pricelevels.

Figure 4: Class Diagram productl.Products
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UOMs (Units of Measurement)

4 UOMs (Units of Measurement)

openCRX UOMs are what you would expect them to be: any division of quantity
accepted as a standard of measurement or exchange. openCRX includes a
variety of typical UOMs in the Root segment (but it is straight-forward to define

your own UOMs):

Home  Accounts Activities Pipeline Products Depots »
. UOMs

Edit WView Security Wizards

Units of Measurement UOM Schedules

bl P W =Y HOMmEE New Edit View

M [] Hame « Description = Quantity = UOM schedule =
A Ampere (electric unit) 1.00 Sl
Al 0.2402896415m x 1.135207115m 1.00 IS0 Standard Paper Sizez
K Kebvin (temperature) 1.00 Sl
Piece(z}  Piece(z) 1.00 Other
Unit(z} Unit(=} 1.00 Other
cd Candela 1.00 3l
kg Kilogram (mazz) 1.00 Sl
m Meter (diztance) 1.00 Sl
mal Maole (amount of substance} 1.00 Sl
8 Second (time) 1.00 Sl

Figure 5: UOMs of the Root Segment

| Segment A wroots
Imporer
=g id : string =g id : string
+ sEgMment +segnant o amaots
SegmentContainsUom SegmentContainslU om Schedule Sl
UomlsEasedCOnlom i —
+ biiauﬂm + pom + yom + womSghedule —1 SecureObj..
0.1 - 0.1 d..1
Uom UomMemberOfllom Schedule UomSchedule
+name : string LS5 5_1rir-; .
o P B o o + descriphion : string
+ description ; string P -
+-:adail=.~:|:lascri|:r1i;r - string +uom + pomSchadule | +@etailedDescription : string
+ quantity : decimal
+ isScheduleBaselom : boolean
a wroofs
J; [ b Iy ! This software is published
_ under the BS0 license as
= wroofs = p—— listed below. see class
DegcripdonConginer Ex p— diagram _LICENSE
—
" wroofs
- SecureQbjecr [H———

Figure 6: Class Diagram uom1.Main
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5 Basic Pricing

In this chapter we will present a high-level overview of how product pricing
works in openCRX. The relevant class diagrams are all located in the package
org.opencrx.kernel.productl (AbstractProduct, PricelLevel, Pricelist,
and PricingRule).

5.1 Prices of Products

The following class diagram excerpt shows the classes and associations that
are relevant for “attaching” prices to products:

arpots
AbstracitProduct

+ |progdiuct

+ upm
ProdyctPricel evel DefingdForlom
+ basaPrice
y 0.1
ProductBasePrice

+ I:-aiaF'rica

o
gt
AbsraciProdu ctPrice
+ alists usage : code
+ price : decimal [0..1]
+ priceCurrency : code
+ description : string [0..1]
+ quantityF rom : decimal [0..1]
+ quantity To - decimal [0..1]
+ discount : decimal [0..1]
+ discountls Percentage : boolean [D..1)

Figure 7: Class Diagram productl.Prices — ProductBasePrice

There are a few things to note:

e Yyou can attach any number of prices (called ProductBasePrice) to a
Product (including no prices at all, i.e. prices are optional)

e currency (priceCurrency) and unit of measurement (uom) should be
specified for each price




openCRX Package productl - Version 2.6.0 Basic Pricing

The following figure shows an example Product Widget A with 3 different
Base Prices:

Home Accounts Activities Pipeline | Products Depots »
55 Products = Widget A | WA-1000 - Product

File Edit View Actions Security Vizards

General || Details | System =

Mame: Widget A Product number: WA-1000
Description: Large Widget ActiveValid from:

Product status: Active Expires on:

Min positions: Default positions:

Max positions:
Cenfiguration type:

Min quantity: Default quantity:
Max quantity: [min..max] handling: 0
Offset quantity:

Detailed desoription

Active Base Prices EIaEEF‘rll:EE Price UCMs | | Addresses  Descriptions

“o . _\ ............ - R

L D Price Levels = Usage Currency = Price = Unit of measurement = Description = Guantity from = Guantity to =
33 Standard EUR 100.00 Fieos(s)

- Sales EUR 20.00 Pieca(s) 9.00

34 Sales EUR 80.00 Fisce(s) 10.00

Figure 8: Widget A with 3 different Base Prices

The price of EUR 100.- is valid for any quantity and linked to the PriceLevel
Standard, while the price of EUR 90.- is valid for quantities up to 9 pieces
(linked to the PricelLevel Sales) and the price of EUR 80.- is valid for
quantities of 10 and more pieces (and also linked to the PriceLevel Sales).

Please note that Base Prices “inherit” information like the validity

range from the Price Level they are linked to.
Important

5.2 Price Levels

PricelLevels are very useful constructs to combine products and their prices
and to define the period of validity for prices (think of price lists). With
PriceLevels you can also establish relationships between accounts and prices,
e.g. define which accounts are eligible for which prices. In addition to
these basic “features”, price levels also offer a variety of operations to highly
automate the management of product prices and price lists in even the most
complex environments.
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PricelevellsEasedOn

+segment

SegmentContainsPricelevel

This seftware is published
uneder the BED license as listed
below. se== class diagram

A Fricelevelis active if the pricin
Pricelevel [validFrom, validic

_LICENSE

g date is in IT

+ pricglevel + bagedOn +dervedHricelavel |
P o1 i PriceLevel
0. ..
AbstraciPricel e

+name : string

+ description : string [0..1]

+ alists shippingMsethod : code
+ dlists paymentMethod : code
+ priceCurrency : code

+ dlists pricellsage : code
+isFinal : boolean [..1]

+ validFrom : dateTime [D..1]

+ validTo : dateTime [0..1]

+clonePricelevel | in : ClonePricelevelParams | : ProcessPricesResut

ProductPhasePricelev

+ productPhaselzy - string [0..1]
+defaultOffsetValidF romHh
+defaultOffsetValidToHh : integer [0.1]

nteger [0.1]

+cloneProductPhasePricelevel | in : CloneProductPhassPricelevelParams | : ProcessPricesResut

+calculsteFrices {in: CalculateFricesFarams | - FrocessPriceshesut

+ removePrices | in : RemovePricesParams ) : ProcessPricesResut
+crestenitizlPrices [in : CrestelnitizlPricesParams | : ProcessPricesResut
+removePricelevels | in : RemovePricelevelsParams | - ProcessPricesResul

+ pricglavel 2]

wroofs
BasicObject

PriceLevelHasHAriceModifier

+ priceModifier
:| A

g M : String

+ pricelevel

PriceLevelHasAssignedPricelisEnty
+ pricallistEntry H
0.1 | JisFrozen}

A ProductPhasePricelevel is active if the pricing date is in [ProductPhase. validFom,
ProductPhase validTo] where ProductPhasePricel evel productPhasetey =

ProductPhase
ctive if the prici
Product. sctiveOn+defaultOffs etV alidTcHh

ductPhasekey. If no ProductPhase is found, then the Pricelads
te is in [Product. sctiveOn+defaultOffs 2tV sldFomHh,

PriceModifier
+ quantityFrom : dacimal [0.1]

PriceListEntry

iantity To : decimal [0..1] T

mox

+ description : string
DiscountPriceModifier
iscount : decimal [D..1]

price level.

List of all product base pricas
with pric= level matching the

clonePricelevel]) 1. clones the price level and all based on price [EN
levels. Cloning includes PriceModifier, AccountFilter and
ProductFilter. 2. prices are clones

woriginal and cloned price level) with the original prics level.

pending on the processing
d prices are not shared {price object references

+ discount|sPercentage : boolean [0.1]

LinearPriceModifier
+ priceMultiplie
+ price(ffs=t

Price medifiers. ane used for
the create prices operation

remaoveFrices() 1. get all prices wih

~ | price. priceLevel]) contains{pricelevel 2 F
price. pricelevel). sizey==1
price. priceLevel]). sz * 1 remove pricelevel from
price. pricelevel)

remove the price 3. if

+ roundingFacter : decimal [0..1]

derivedPrice = Floor{price * priceMultiplier * roundingFactor + 0.5)/ roundingF acior
+ price0ffst

]

ereatelnitialPrices() 1. get ll preducts matching the preduct filer [
2. If the preduct does not have a price with
price. pricelevel]). contains{pricelevel) craate a new price wih
price, quantity and discount initislized to O

Figure 9: Class Diagram productl.PricelLevel

ealeulstePrices() Caleulates / recalculstes the prices of the piod [
level and recursively of allbas

2dOn price levels.

Next, we will discuss how products, prices and accounts can be “linked” to
price levels, based on this sample data (see chapter 2.1 Sample data):

EUR 100.-

Product Widget A

EUR. 90.-

EUR. 80.-

-

¥
SalesTaxType Sales Tax 8.5% Pricelevel Sales
tax rate in %: B8.50 valid from: 01-05-2010
wvalid to: 16-05-2010

Product Widget B

EUR 40.-

EUR 60.-

Pricelevel Standard

valid from: 01-01-2010
vald to:

Figure 10: Sample data - 2 products, 2 price levels, 5 base prices
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5.2.1 Assigning Prices to Price Levels

The following class diagram excerpt shows the classes and associations that
are relevant for “assigning” prices to PricelLevels:

algots
AbsoractProduct

+ product
+ [prgedinct
+ profuct
ProductHasDgfaulilom ProductH asDefaultPriceleve
ProductH asProductBasePri
+ defapltlUom + defaultPripelevel
0.1 0.1
2] AbsractPricel e
0.1
+ upm + pricglevel
ProdyctPricel evel DefingdForom
+ basaPrice
0.1
ProductBasePrice
BasePricelsAssignedToPricelevel
+ bagePrice
T T
arpots
AbsracitProducifrice

+ alists usage: code
+ price : decimal [0..1] -
+ priceCurrency : code
+ description : string [0..1] o

. : . + baseFrice
+ quantityFrom : decimal [0..1]
+ quantity To : decimal [D..1]
+ discount ; decimal [0..1]
+ discountl s Percentage | boolean [0..1

Figure 11: Class Diagram productl.Prices — PriceLevel

There are a few things to note:

® YoOu can assign a particular price to any number of price levels (and
assigning prices to price levels is actually optional)

e prices do not have a date validity range as date validity ranges (valid
from, valid to) are defined by price levels

e the currency of a price must be in agreement with the currency of the
price level the price is linked to

e Yyou can (optionally) define a default price level for each product

While you can assign prices to price levels manually, such assignments (or
even the calculation of prices to be assigned) is typically done in an automated
manner, e.g. by means of executing operations like Create Initial Prices.
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Let us have a look at the product Widget A:

Home Accounts Activities Pipeline | Products Depots »
&3 Products = Widget A | WA-1000 - Product
File Edit View Actions Security Wizards

General || Details = System

Mame: Widget A Product number: WA-1000
Desaription: Large Widget ActiveValid from:
Product status: Active Expires on:

ice UOMs | | Addresses | | Descriptions

MNew Edit View

M |:| Frice Levels = Usage Currency = FPrice = Unit of measurement = Description = GQuantity from = GQuantity to =

35 Standard EUR 10000 Piecels)
.ﬂj Sales EUR 20.00 FPizoz(s) 2.00
33 Sales EUR 80.00 Piece(s) 10.00

Figure 12: Product Widget A and its prices

This product has 3 Base Prices, 1 linked to the Price Level Standard and 2
linked to the Price Level Sales. Not that the sales price depends on the
quantity, i.e. up to 9 pieces the price is EUR 90.--, for 10 pieces and more the
price is EUR 80.--. Let us now add another sales price that applies to quantities
of 100 or more pieces:

e in the grid [Base Prices] select the menu New > Product Base Price and
then enter data as shown below:

Untitled - Proeduct Base Price

General | | System  |*

Usage: = Cumrency: EUR [Eurg] [v]
Price: 75
Unit of measurement: Piece(s)
Desoriction: R RIS
(T.usntity'f’:ﬁ'l: 1|;||;|] Discount is %: |:|
Liuantity to: Discount:

Save| | Cancel
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« click [Save] and then click on the newly created Product Base Price as
shown below to navigate to it:

Home Accounts Activities Pipeline | Produets Depots »

&4 Products = Widget A | WA-1000 - Product

L}

File Edit Wiew Actions Security Wizards

Product Base Price: 75 EUR [Eurg] [Edit]
General || Details| | System| | =| 75 ELUR [Eurc]
Marne: Widget A Proc

« in the grid [Price Levels], enter a reference to the Price Level Sales
(use the auto-completer) as shown below:

Home Accounts Activities Pipeline | Products Depots »
34 Products = Widget &/ WA-1000 = 75 EUR [Euro] - Produc

L]
File Edit View Actions Security Wizards

General || System
Usage: Cumenc
Price:
Unit af i
Desoription:
Cuantity from: 100.00 Discoun
Cuantity to: Discoun
Price Levels
Edit
sal =}
Sales [Salgs]
— k urr Name Based on From t

» select Edit > Add Object as shown below:

Price Levels

Edit

« the newly added reference to the Price Level Sales should now be
shown in the grid [Price Levels] of this new sales price:

Frice Levels

Edit

L |:| Curr Name

B EUR Sales
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e navigate back to the Product Widget A and verify that the new sales
price of EUR 75.-- for quantities of 100 or more does actually show up in

the grid [Base Prices]:

Home Accounts Activities Pipeline | Products Depots »

&3 Products = Widget A | WA-1000 - Product H B X
L]

File Edit WView Actions Security Wizards

General || Details | System | =

Mame: Widget A Product number: WA-1000

Description: Large Widget ActiveNfalid from:

Product status: Active Expires on:

Min positions:
Max positions:

Configuration type:

Min quantity:
Mazx quantity:
Offset quantity:

Detailed desoription:

Active Base Prices || Base Prices  Price UOMs | | Addresses | Descriptions || »

Ll 5 ENBNMNE

L I:l Price Levels = Usage Currency = Price ¥
&3 Standard EUR 100.00
34 Sales EUR 50.00
&3 Sales EUR 80.00
d4  Sales EUR 75.00

Default positions:

Default gquantity:
[min..max] handling: 0

A

New Edit View 14)

Unit of measurement = Description = Quantity from = Guantity to *

Pizce(s)

Fizca(s) 5.00
Piece(s) 10.00

Pizoe(s) 100.00
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5.2.2 Assigning Products to Price Levels

On the one hand products are assigned to price levels implicitly by manually
assigning product prices to price levels. More interestingly, however, is the use
of product filters to automatically “assign” products to price levels:

This software is publis hed
under the BS0 license as
listed below. s== class
dizgram _LICENSE

AbstraciPricel e

] arpots
AbsoraciFiler
4]
algots
AbsractFilrerProduct

+ countFiteredProduct { ) :

CountFiteredObjects Resut

“ wroofs
BasicObjec
ProductFilterHagFilterProperty
A alDots I wroofs
AbsiraciFil rarPropety Eecured... + productF |terProperty
Produ ctFil rerPropery
= aroots = aroots
ArribureFilterPropey QueryFilrarPropemy

3 3

Producc ribu reFil rarPropery ProductQueryFilterProperty

+ prodyctFilter

Filterinelu

+ filteredP roduct
0..1 | fisFrozen}

aloots
AbstraciProduct

CategoryFilterProperty

DisabledFilterProperty

+ alists categorny : string

+ disabled : boolean

ProductClassificationFilterProperty

DefaultSalesTaxTypeFilter Property

PricelomFilterProperty

S indes; ; integer | S indes; ; integer i index : integer
+ fiterAroparty + fiterPropearty + filterHroperty

FilterPropertyHasPpoductClassification FilterPropertyHas SalesTaxType FilterPropertyHasPricellom

+classification + s3lesTaxTyps + prigellam
0.1 0.1, oot
ProductClassification BalesTaxType =] Uom

Figure 13: Class Diagrams productl.ProductFilter / PriceLevelProductFilter

The shared association filteredProduct yields all products that are assigned
to a particular price level based on the defined product filters (or all products in
case no filters are defined). This construct (combined with various price level
operations) enables you to create price lists based on product criteria in a
highly automated fashion.

If you create a new Price Level, there is (by default) no product filter defined.
In the absence of a product filter, the grid [Products (Filtered)] of a Price Level
includes all products.
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5.2.3 Assigning Accounts to Price Levels

You can manually assign accounts to price levels with AccountAssignments.

Such account assignments also allow you to define discounts that apply to a
particular account only:

=]

1 grodots a aroots This softwane is published
CrrObjecr AbstractFilterA coount under the BED license as listed
[ [ [Sia - string | below. 522 class diagram
| AbsiraciPricel e | 1 _LICENZE
+ sccoyntFilter
i id : string
FilterlncludesAccount
+ pricelLevel ) armots
) . ) + fitzregAccoun AccountAssignment
Pricel evelHasAsrigned unt 0.1 fisFrozen} + validFrom : dateTime [0..1]
+ 3ssignidAccount [=] ACcount + validTo : dateTime [0..1]
0. ] .
AccountAssignment Q.1 FEsEgnman
+ discount ; decimal [0..1] +acgount HasAssigned Account
+ discountlsPercentage : boolean [0.1] + 3otount
0.1
_ 4? HasAssigned Account Account
= aroots .
Accountssignment -
+ assignment

Figure 14: Class Diagrams productl.PriceLevelAccountFilter

Account filters allow you to automatically “assign” accounts to price levels:

- - - e aroots

This software is publis had AbstractFiler

wnder the BED license a5 I;'.-.

listed below. seeclass —

diagram _LICENSE arois
=L AbstractFiloerA coount

+ countFiteredAccount { ) : CountFilteredObjects Resut

id : string

+ accountF ilter

+ sccopntFilter
AccountFilterHasFilterProperty

FilterlncludesAccount

.z:mmﬁm 9 wroofs " wroofs
Securedbject BasicObject ,
W,,. W Obj Obj + secountF terPropey {isFEfc'%:'F? c__c-ll. nt
& ii'.‘n ii& ot 0. fis Froz=n}
Accoun iFil rerPropey Account
= . "':Nt' gl aroots
AwribureFilrerPropeyy QueryFilcerPropey
T )
Accoun tAri bureFil rerPropey AccountGueryFilterProperty
[ I
AccountTypeFilterProperty CategoryFilterProperty
+ glists SccountType : code + alists category - string
AccountCategoryFilterProperty DisabledFilterProperty
+ alists accountC ategory ; code + disabled : boolesn

Figure 15: Class Diagram accountl.AccountFilter
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The shared association filteredAccount yields all accounts that are assigned
to a particular price level based on the defined account filters (or all accounts
in case no filters are defined). This construct (combined with various price level
operations) enables you to create account-specific price lists highly automated.

If you create a new Price Level, there is (by default) no account filter defined.
In the absence of an account filter, the grid [Accounts (Filtered)] of a Price
Level includes all accounts.

5.2.4 Price Lists

In addition to the “global price list” (the price list containing all product prices
in any currency) openCRX provides a Price List for each Price Level. Such a

price list contains all product prices that are assigned to the particular price
level.

Segment This software is published
under the BS0 license as
g i : string listed below. se=class

dizgram _LICENSE

+ segment

SegmentContainsPricelistEnry p——
+ pricelitEntry AbsractProdu ctPrice
0.1 | fisFrozen} -JlL-
PricelistEntry PriceListEntrylsPriceQfPriceEnabled

+ producthl ame : string 0.1 aroots

+ pre-ductD escription : string [0..1] T .| AbstraciProduc

+ preductDisabled : boolzan [0..1] e + product

PricelistEntryHasProduct SalesTaxType

. 0.1 SalesTaxType
+ pricelistEntry + salesTauTyps i

PricelListEntrylsBased OnPrice

2.1_[ ProductBasePrice
+ pricelistEntry + basePrice

- !

= aroots I aroots
EecureObjec BasicObject

Figure 16: Class Diagrams productl.PriceList

Please note that price lists are derived information, i.e. you do not explicitly
define price lists, but rather you assign product prices (or products with prices)
and accounts to price levels (see sections Assigning Products to Price Levels
and Assigning Accounts to Price Levels for details).
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5.2.5 Sample Price Level Sales

The following figure shows the Price Level Sales with the respective (derived)
Price List, filtered products and filtered accounts:

Home Accounts Activities Pipeline | Products Depots »
2 Products = Sales - Price Level
L]

File Edit View Actions Security Wizards

General | System

Mame: Sales Is final: F1

Based on: Valid from: 51/2010 6:0
Valid to: BME/2010 10

Description: Sales Prices

Conrac Fibers:

Payment methods: Shipping methods:

Frice Fikers

Cumency: EUR [Eurg] Price usage:

Frice Modifiers |

" A pOQOME  view

L D Price Levels = Product name = Product = Usage Currency ™ Price ™ UOM = Description = Quantity fr
-] Sales Widget A Widget A/ WA-1000 EUR 3000 Pisce(s)

- Salas Widget A Widget A/ WA-1000 EUR 2000 Piece(s) 10.00

-] Sales Widget A Widget A/ WA-1000 EUR 75.00 Pieos(s) 100.00

-] Sales Widget B Widget B / WB-1020 EUR 4000  Pieoe(s)

Products (Filtered) | | Product Filter

L g, EREMNE View
L D Item number = Product # = Name = Description =
&3 0 WaA-1000 Widget A Large Widget
=1 0 WEB-1020 Widget B Small Widget
Aecounts (Filtered) | | Accounts (Manually Assigned) | | Account Filter
HH a, ENENME View
L] D Full name = Alias name = Phone business Phone mobile E-mail business Organizatic
i Guest,
i admin-Standard,
i admin-Standard~Private
it guest-Private

Figure 17: Price Level Sales with Price List, filtered Products and Accounts
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5.3 Pricing Rules

Pricing rules are used to automatically determine an appropriate price
level for a contract position based on any algorithm you like (e.g. “select
the price level with the lowest price a particular account is eligible for” - see
section Pricing Rule LowestPrice for details). Pricing rules are basically "scripts"
that are programmed in Java and have access to the complete API of openCRX
(and anything else that is available, including third-party systems like billing
systems, etc.); the scripts are compiled on the fly at runtime (we use Janino -
http://www.janino.net/ - an embedded Java compiler) for maximum flexibility,
i.e. scripts can be added/modified/deleted at runtime!

5.3.1 Pricing Rule LowestPrice

openCRX provides a sample pricing rule called Lowest Price:
Home Accounts Activities Pipeline | Produets Depots »

B Products = Lowest Price - Pricing Rule

File Edit View Actions Security Wizards

General || System

Mame: Lowest Price Is default:
Description: Get price level which returns the lowest price of the given produdt, contract cumency,
pricing date and quantity. If the product is not defined return the price level which matches
the contract cumency, price uom and pricing date.

Price level sonipt:

public static org.opencrx. kernel productl. jmil . GetPricelevelBesult getPia
org.-openmix _base_accessor. jmi.cci.BefPackage 1 0 rootPkg,
org.opencrx. kernel  productl . jmil_ PricingBule pricingBule,
org.opencrx. kernel . contractl. jmil._ AbstractContract contract,
org.opencrx. kernel  productl . jmil_AbhstractProduct product,
org.opencrx. kernel _uoml . jmil . Tom priceUom,
java_math_ BigDecimal guantity,
jara_util.Date pricingDate

return org.opencrx.kernel _backend. Products. getlowestPricePricele
rootPhg,
pricingBule,
contract,
product,
pricelom,
quantity,

pricingDate

Figure 18: Pricing Rule Lowest Price

In a nutshell, here is how this pricing rule determines the price level with the

lowest product price given a contract (e.g. a quote or a sales order, which also
defines the customer [= account] and a contract currency), a product (on each
contract position), and optionally a quantity (useful for quantity-based pricing),
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a pricing date (useful for look-back or forward pricing) and a unit of
measurement for the price:

e determine candidate price levels such that

pricing date is within validity range of price level

contract currency matches currency of price level

customer is assigned to price level (manually with an account
assignment or implicitly with an account filter)

product is assigned to price level (manually by assigning product price
to price level or implicitly with a product filter)

e determine price level with lowest product price by checking relevant
prices (including discounts) of all candidate price levels

5.3.2 Pricing Rule Precedence

Pricing Rules can be defined both at the Contract level and at the
ContractPosition level. The following rules apply:

e Specifying a PricingRule is optional at the time of creating a new
Contract. If no Pricing Rule is specified, the respective field simply
remains empty.

e Specifying a PricingRule is optional at the time of creating a new
ContractPosition (with the operation Create Position). If no Pricing Rule
is specified, then the Pricing Rule of the Contract (if specified) is assigned
to the newly created Contract Position; if there is no Pricing Rule
specified at the Contract level, then the default Pricing Rule (if specified)
is assighed to the newly created Contract Position. If no default Pricing
Rule is specified then the respective field simply remains empty.

Automated pricing of a ContractPosition requires that a PricingRule is
assigned to the respective Contract Position (either automatically or then
manually). Contract Positions without assigned Pricing Rules cannot be
(re)priced automatically and their pricing status remains “dirty”.

Automated pricing of a Contract requires that all of its Contract Positions can
be priced automatically. If at least 1 Contract Position cannot be priced
automatically (i.e. its pricing status remains “dirty”) then the Contract cannot
be priced automatically and its own pricing status is set to “dirty” as well.

Imporiant

Properly assigned Pricing Rules are no guarantee that a
Contract and its Contract Positions can be automatically
priced. Automated pricing also requires that at least 1 valid price is
available, i.e. a price with matching currency that is assigned to a
valid PricelLevel (i.e. pricing date of Contract or Contract Position
within validity range of PriceLevel), etc.
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5.4 Calculation Rules

Calculation rules are used to control the way prices are calculated in terms of
rounding, number of significant decimals, etc. Calculation rules are basically
"scripts" that are programmed in Java and have access to the complete API of
openCRX (and anything else that is available, including third-party systems like
billing systems, etc.); the scripts are compiled on the fly at runtime (we use
Janino - http://www.janino.net/ - an embedded Java compiler) for maximum
flexibility, i.e. scripts can be added/modified/deleted at runtime!

Calculation Rules can be defined both at the Contract level and at the Contract
Position level.

openCRX provides a sample calculation rule called Default:

Home Accounts Activities | Pipeline Products Depots »
B Pipeline = Default - Calculation Rule
File Edit View Actions Security Wizards

General || System

MNams: Default |5 default:
Description:

Paosition amounts soript:

public static org.opencrx. bernel  contractl. jmil  GetFositiondmountsBes
org.openmdx . base . accessor. jmi.cci_ RefPackage 1 0 rootPkg,
org.opencrx. kernel . contractl. jmil_ CalomlatiomBule calculationBule

org.opencrx. kernel . contractl. jmil _AbstractContractPosition positd
java . math._ BigDecimal minMawhdjustedfuantity,
java . math_ BigDecimal uom3caleFactor,
java.math_BigDecimal salesTaxRate
return org.opencrx. kernel _backend Contracts.getPositionfmount
rootFPkg,

calrulationBule,
position,
minMawddjustedfnantity,
uomcaleFactor,

salesTaxRate

Contract amounts soript:

public static org.opencrx. kernel  contractl. jmil | GetContractimountsBes
org.openmdx . base . accessor. jmi.cci_ RefPackage 1 0 rootPkg,
org.opencrx. kernel . contractl. jmil_ CalomlatiomBule calculationBule

Figure 19: Calculation Rule Default
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6 Some Examples

In this chapter we create some samle contracts and contract positions based
on the sample data (see chapter 2.1 Sample data) and the additional sales
price of EUR 75.-- for Widget B (created at the end of chapter 5.2.1 Assigning
Prices to Price Levels) to show how this all fits together.

6.1 Widget A and Widget B with standard pricing
Let us create a sales order with 2 positions as follows:
e nhavigate to [Pipeline]

« execute File > New Sales Order and populate at least the fields Contract
name, Account, Active/Valid from, Currency and Contract number
in the first field group and then enter a delivery and billing address in the
second field group:

Contract name: standard pricing Sales rep: =
Account: Guest, [Guest,] =" Contract number: S0-1

Active/Valid from: 4/19/2010 7:00:00 PM ¥  Excpires on: i
Cumency: EUR [Euro] W Payment terms: NI/A b
Priority: MiA W Crigin:

Fricing

Pricing rule: Lowest Price ~
Calculation rule: Default ~
Addreses (SRipping ¢ S0ng

Shipping method: MN/A L

Address line(s): Mr. Guest Address linefs): Mr. Guest

Street / PO Box: #1 Delivery Loop Street / PO Box: #1 Billing Drive

City: Delivery City: Bill

ZIF/Postal code: g9aTes Z|IF/Postal code: FET29

Country/Region: United States of America [US] |w Country/Region: United States of America [US] |

Please note that the Active/Valid from date should be later than
1-Januar-2010, but outside of the period 1-May-2010 through
16-May-2010 as this ensures that positions are priced with the price
level Standard as defined by our sample data.
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 next we add a position with 25 Widgets A as follows:
jJ‘_L.sl;'ti'q;':
Product: Widget A / WA-1000 [Widget A]
Pos-Name: A

K

click on the button [+] to add this position A and verify that the price
was (automatically) set to 100:

PosiElons:
Cuantity Product Pos-Name Price per unit Base amount

- 25 | Widget A/ WA-101 A 100.000000000 2500.000000000
Corract Posizhon
Cruantity: 25 00
Preduct: Widget A / WA-1000 L
Pos-Name: o
-

next we add a position with 5 Widgets B as follows:
T_L.-s;r'tity:

Product: Widget B / WB-1020 [WB-1020]

FPos-Mame: B1

T

click on the button [+] to add this position B1 and verify that the price
was (automatically) set to 60:

Poesikores.
Cruantity Product Pos-Mame Price per unit Base amount

- 25 Widget A/ WA-10I A 100.000000000 2500.000000000

- 5 Widget B/ WB-1021 B1 60.000000000 300.000000000
Comrac Posithon
Cuantity: 5.00
Froduct: Widget B / WB-1020 a,
Pos-Name: B1
-

click on the button [Create Sales Order] to create this sales order
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e your newly created sales order should look as follows:

General System

Account: Guest, Sales order number: 501
Mame of sales order: standard pricing State: LI 17
Deszcription: Prigrity: MiA
Sales order language: MiA Activenalid from: 4119/2010 7:00:00 PN
Origin: Expires on:
Sales rep: Guest, Cancel on:
Broker: Clo=ed on:
Supplier:
Submit date: . . Status description:
Submit =tatus: MiA
Shipping method: MIA Shipping instructions:
Carrier: Gift: Fl
Tracking number: Gift mez=zage:
Freight terms: MNiA
Pricing infonmation
Pricing rule: Lowest Price Pricing statuz: dirty / repricing rec
Calculation rule: Default Pricing date:
Financlal Imbrmation
Currency: EUR [Euro] Total base amount: 2,800.00
Payment terms: MiA Total dizcount: 0.00
Sdles commission: 0.00 Total (excl. tax): 2,800.00
Total tax: 238.00
Toetal {incl. tax): 3,038.00
Positions  Addresses || Delivery Requests | Account Assignments | Competitors | | Related Activities || Linked To || Inbou
| =Y HOENEE View
[+l D Pos# = Pos-Name = Product = Guantity = UOM (quantity} = Pricing status = UOM (price} = Price per
Widget A e
& 100000 A / 25.00 Piece(z) f'”ii’rcr;””':'"g Piece(s) 100.00
WA-1000 equire
Widget B
& 200000 B ! 5.00 Piece(s) oK Piece(zs) 60.00
WB-1020

Please note that the wizard does not set the Pricing date.

Imoriam  Please note that pricing of the sales order positions (and hence the
sales order is based on the value of the attribute Pricing date (if
set!); if Pricing date is not set, then the pricing is based on prices
applicable on the sales order's Active/Valid from date.

You can reprice the sales order at any time by executing the
operation Actions > Reprice.
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6.2 Pricing per Pricing date or Active/Valid from date

Let us continue with the sales order created in the previous chapter 6.1 and
see what happens if we change the Pricing date:

e navigate to the sales order named standard pricing and change into
edit mode (execute Edit > Edit)

« set the Pricing date to 5/2/2010 2:00:00 PM and then click [Save]:

General System

Account: Guest, Q. Salez order number: S0-1

Mame of =ales order: standard pricing State: HiA [v]

Description: Priority: MiA [+

Sales order languages: NiA [v] Active/valid from:

Origin: Q, Expires on:

Sales rep: Guest, Qa, Cancel on:

Broker: Q, Closed on:

Supplier: a,

Submit date:; 412312010 1:27:30 Pr Status description:

Submit status: NiA [v]

Shipping method: NiA [v] Shipping instructions:

Carrier: Q. Gift: |

Tracking number: Gift mez=zage:

Freight terms: HIA [v]

Pricing Infanmation

Pricing rule: Lowest Price a, Pricing =status: dirty ! repricing requ

Calculation rule: Default Q,  Pricing date: 522010 2:00:00 PM ¥

Flnancial information

Currency: EUR [Euro] [v] Total baze amount: 2,500.00

Payment terms: NiA [v] Total discount: 0.00

Sales commigzion: 0.00 Total (excl. tax): 2,500.00
Total tax: 238.00
Total (incl. tax): 3,038.00

Save| | Cancel
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execute Actions > Reprice and verify that the prices per unit dropped to
80.00 for Widget A and to 40.00 for Widget B, i.e. setting the pricing
date to a date inside the sales period (1-May-2010 through 16-May-
2010) causes the lowest price algorithm to pick the sales prices. At the
contract level all the totals were automatically recalculated as well:

Financial infonmation
Currency: EUR [Euro] Total baze amount: 2,200.00
Pavment terms: MiA Total dizscount: 0.00
Sales commizsion: 0.00 Total (excl. tax): 2,200.00
Total tax: 187.00
Total (incl. tax): 2, 387.00
Pnsitinns | Addresses | Delivery Requesis | Account Assignments | Competitors | Related Activities | Linked To || Inbound
Links
| Q, HOENE View
*l |:| Pos# = Pos-Name = Product = Guantity = UOM [guantity) = Pricing status = UOM (price} = Price per unit
Widget A
100,000 A 25.00 Piece(s) oK Piece(s) 20.00
Wa-1000
Widget B
200,000 B 5.00 Piece(s) oK Piece(s) 40.00
WB-1020

Let us now continue with this sales order and see what happens if we change
the Active/Valid from date:

navigate to the sales order named standard pricing and change into
edit mode (execute Edit > Edit)

set Active/Valid from to 5/20/2010 8:00:00 AM and then click
[Save] (the Pricing status changes to “dirty / repricing required”)

execute Actions > Reprice and verify that the prices did not change
(because Pricing date overrides Active/Valid from), but the Pricing
status was set to OK:

Pricing Infonmation

Prizing rule: Lowest Price Pricing status: OK
Calculation rule: Default Pricing date: BI212010 2:00:00 PRI
Firenclal information
Currency: EUR [Euro] Total base amount: 2,200.00
Payment terms: NiA Total dizcount: 0.00
Sales commigsion: 0.00 Total (excl. tax): 2,200.00
Total tax: 187.00
Toetal (incl. tax): 2, 387.00




openCRX Package productl - Version 2.6.0

Some Examples

6.3

Volume Discounts

The sales price of Widget A is prepared for volume discounts, that is in
quantities up to (and including 9) the price is EUR 90.00, in quantities from 10

to 99 the price is EUR 80.00, and in quantities of 100 or more the price drops
to EUR 75.00:

37 WA-1000 Widget A Large Widget
B Q, HOEEE New Edit View
I+l I:l Price Levels & Usage Currency = Price & Unit of measurement = Description = CGruantity from
44 Sales EUR 75.00 Piece(s) 100.00
33 Sdles EUR &0.00 Piecels) 10.00
44 Sales EUR 50.00 Piece(s)

Let us now change the quantity of the position with Widget A from 25 to 150:

navigate to the sales order named standard pricing and change into
edit mode (execute Edit > Edit)

in the Grid [Positions], hover your mouse over the area just to the right
of the position icon and once the context menu shows up select the entry
Edit to load the respective position with Widget A in edit mode:

Positinns | Addresses | | Delivery Requests | Account |
Inbound Links || »

b a HONEEE
*l |:| Pos# = Pos-Name = Product = Guantity *
Widget A
T 100,000 A ! 25.00
000 - Show details Wa-1000
001 - Edit
100 - Addredais Widget B
.131 - Delivery Reguests 2.00
102 - Delivery Information WB-1020
103 - Product Applications
104 - Accounts
In4200 - Product Configurations
301 - Depot References
Ed -

change the quantity from 25 to 150 and then click [Save]:

Widget A
T 100,000 A 2500 Piece(s) 0K Piece(s'
WA-1000
£

General || Details | System

Pos-#: 100,000

Po=-Name: A

Pos-Text:

Quantity: 150

UOM (gquantity): Piece(s) Q
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o execute Actions > Reprice and verify that for Widget A the price per unit
changed from 80.00 to 75.00: (and the totals of the sales orders were
also recalculated):

Home  Accounts Activities | Pipeline Products Depots =

A Pipeline = standard pricing - Sales Order B8 & [X
File Edit Wiew Actions Security Wizards
General System
Account: Guest, Sale= order number: 501
Mame of sales order: standard pricing State: B oya
De=scription: Priority: MiA
Sales order language: MNiA ActiveMalid from: BI20/2010 3:00:00 AM
Origin: Expire= on:
Salez rep: Guest, Cancel on:
Broker: Clo=ed on:
Supplier:
Submit date: 42312010 1:27:30 PM Status de=scription:
Submit =tatus: NIA
Shipping method: MNIA Shipping ingtruction=:
Carrier: Gift: |l
Tracking number: Gift mez=age:
Freight terms: NiA
:"ﬂ':l'r; FronMERon
Pricing rule: Lowest Price Pricing =tatus: oK
Calculation rule: Default Pricing date: BI22040 2:00:00 PM
Firanctal infarmation
Currency: EUR [Euro] Total baze amount: 11,450.00
Payment terms: MNiA Total dizcount: 0.00
Sales commigzion: 0.00 Total (excl. tax): 11,450.00
Total tax: 973.25
Total (incl. tax): 12,423.25

Pasitinns | | Addresses | | Delivery Requests || Account Assignments | | Competitors | | Related Activities | |Linked To
Inbound Links |||~

L] <, AONENE View [1-2)
[+l D Pas# = Pos-Name = Product = Guantity = UOM (quantity) = Pricing status = UOM (price} = Price per

Widget A
& 100000 A i 150.00 Piece(s) oK Piece(s) 75.00
WA-1000

Widget B
& 200000 B i 5.00 Piece(s) oK Piece(s) 40.00
WB-1020
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Finally, let us clear the Pricing date and see how that effects the prices:

navigate to the sales order named standard pricing and change into
edit mode (execute Edit > Edit)

set Pricing date to empty (by deleting the value in the input field) and
then click [Save] (the Pricing status changes to “dirty / repricing
required”).

execute Actions > Reprice and verify that the prices are changed back to
standard prices (because Active/Valid from does not fall into the range
1-May-2010 to 16-May-2010), i.e. Widget A is priced at EUR 100.00 per
unit and Widget B is priced at EUR 60.00 per unit:

General System

Account: Guest, Sales order number: 501

Mame of zales order: standard pricing State: L T

Deszcription: Priority: HiA

Sales order language: s ActivenValid from: BI2002010 S:00:00 AN
Origin: Expires on:

Sales rep: Guest, Cancelon:

Broker: Clo=ed on:

Supplier:

Submit date; /2312010 1:27:30 PM Status description:

Submit status: NiA
Shipping method: MIA Shipping instructions:
Carrier: Gift: Fl
Tracking number: Gift mezzage:
Freight terms: HiA
Pricing Infonmation
Pricing rule: Lowest Price Pricing status: OK
Calculation rule: Default Pricing date:
Franclal infanmation
Currency: EUR [Euro] Total base amount: 2,800.00
Payment terms: MiA Total dizcount: 0.00
Salez commizzion: 0.00 Total (excl. tax): 2,300.00
Total tax: 238.00
Total {incl. tax}: 3,038.00
Positinns | | Addresses || Delivery Requests || Account Assignments | | Competitors || Related Activities || Linked To | | Inb
Links
| =Y HOENEE View
[+l D Pos# = Pos-Name = Product = Guantity = UOM (quantity} = Pricing status = UQOM (price} = Price pe
Widget &
" 100,000 A ! 25.00 Piecels) OK Piece(s) 100.00
WA-1000
Widget B
" 200,000 B1 ! 5.00 Piecels) OK Piece(s) §0.00
WB-1020
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7 Useful Wizards

You might want to have a look at some of the wizards included in the standard
distribution of openCRX if you want to learn about how to program against the
openCRX API and make use of the built-in business logic:

o CreateContractWizard.jsp
o CreateLeadWizard.jsp
e CreateProductWizard.jsp
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8 Next Steps

You might want to have a look at some of the additional documentation
published at http://www.opencrx.org/documents.htm.



http://www.opencrx.org/documents.htm
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